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ABI P

 

RISM

 

 377 XL Upgrade Overview

 

About This
Manual

 

This manual describes the ABI P

 

RISM

 

®

 

 377 DNA Sequencer 
enhancements included in the XL upgrade. Be sure to place this 
manual in your ABI P

 

RISM

 

 377

 

 DNA Sequencer User’s Manual

 

.

 

Upgrade Overview

 

With the XL upgrade, the primary enhancement to the ABI P

 

RISM

 

 377 
DNA Sequencer is the increase in the number of samples that can be 
analyzed simultaneously. This increased throughput was made possible 
by re-engineering the instrument and software to acquire more data as 
the laser scans across the gel.

 

XL-Specific Combs

 

This upgrade also includes new combs specifically designed for 
upgraded instruments. These combs are 48- and 64-well shark’s-tooth 
and 50- and 66-well square-tooth combs. Other ABI P

 

RISM

 

 377 combs 
may be used. 
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Safety Information 

 

Site Preparation
and Safety Guide

 

The 

 

ABI P

 

RISM

 

 377 Site Preparation and Safety Guide 

 

includes 
important safety information that should be read by all users before they 
operate the instrument. Topics covered in the guide include:

 

♦

 

An explanation of the safety labels affixed to the instrument

 

♦

 

Laser safety, including hazards and safe-operation requirements

 

♦

 

Chemical safety, including a waste profile and Material Data Safety 
Sheets for the chemicals commonly used with the instrument

We strongly recommend that this guide be kept readily available for 
reference at all times.

 

Ergonomic Hazard

 

! WARNING !

 

ERGONOMIC HAZARD. Performing loading activities 
may increase the risk of developing cumulative trauma disorders 
(repetitive motion or repetitive strain injuries), which include but are not 
limited to: tendonitis, tenosynovitis, epicondylitis, strains, and/or sprains. 
To reduce the risk of these disorders, the following recommendations 
have been developed to decrease awkward posture, repetitive motion, 
excessive force, static muscle loading, and soft tissue contact.

 

♦

 

Use an automated multi-channel pipet loader.

 

♦

 

Locate the instrument on a variable or predetermined-height 
worktable or lab bench.

 

♦

 

Use a stable stool or stepladder.

 

♦

 

Install adequate lighting in the appropriate area to facilitate loading.

 

♦

 

Ensure adequate front access to the instrument while performing 
loading activities.
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Loading Volumes

 

Loading
References

 

The new combs require smaller loading volumes. For more information, 
refer to:

 

♦

 

The loading volume tables in this manual

 

♦

 

The

 

 

 

ABI P

 

RISM

 

 377

 

 DNA Sequencing GeneScan Chemistry Guide

 

 
(P/N 4303188)

 

♦

 

The

 

 Automated DNA Sequencing Chemistry Guide

 

 (P/N 4305080)

 

Tips on Loading
Small Volumes

 

Loading the small volumes required by the ABI P

 

RISM

 

 377 XL upgrade 
is easier if you use a gel-loading syringe, such as a multiplexed loader 
of four or eight syringes arrayed to match the XL upgrade well spacing. 
An alternative is an adjustable volume pipet with 0.17-mm gel loading 
tips. Volumes below 1.0 µL may be difficult to load with a pipet.

For best resolution, loading volumes should be smaller when using the 
12-cm separation distance. Loading volumes of 0.5 µL are acceptable. 
You may find it possible and advantageous to use even smaller 
volumes.

 

Loading Volumes
for Sequencing

 

Use the following table to determine resuspension and loading volumes 
for sequencing based on the comb configuration used. 

 

! WARNING !

 

CHEMICAL HAZARD. Formamide is a known 
teratogen. It can cause birth defects. Wash thoroughly after handling 
formamide. Wear appropriate protective eyewear, clothing, and gloves. 
Obtain a copy of the MSDS from the manufacturer. Wash thoroughly after 
handling formamide.

 

Comb Configuration (No. of Wells)

 24/36 Wells 48 Wells 64 Wells

 

Resuspension vol.

 

a

 

 (µL)

 

a. 5:1 Deionized formamide to 50 mg blue dextran/mL 25 mM EDTA

 

6–9 2–4 2–4

Loading vol. (µL) 1.5 0.5–1.0 0.5–1.0
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Loading Volumes
for GeneScan

 

Use the following table to determine component and loading volumes 
for GeneScan based on the comb configuration used.

 

Comb Configuration (No. of Wells)

24/34 Wells 50 Wells 66 Wells

 

Deionized formamide 
(µL)

2.5 2.5 2.5

50 mg Blue dextran/mL 
25 mM EDTA 
(P/N 402055) (µL)

0.5 0.5 0.5

Size standard

 

a

 

 (µL)

 

a. If the peak heights fall below 50 fluorescent units, increase the concentration by doubling 
the volume of the size standard in the cocktail.

 

0.5 0.5 0.5

DNA (µL) 1.5 1.5 1.5

Loading vol. (µL) 1.5 1.0–1.5 0.5–1.0
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Lanes, Combs, and Run Modes

 

Lanes, Combs, and
Run Modes Table

 

The number of lanes, the types of combs used, and the corresponding 
run modes are shown in the following table.

 

IMPORTANT

 

For 48, 50, 64, and 66 lanes, you must use XL Scan Run mode.

 

Lanes Comb

 

a

 

a. Well spacing for the XL combs is 9 mm on center to accommodate multichannel 
pipettes.

 

Run Mode

 

24 Shark’s-tooth Full Scan

24 Square-tooth Full Scan

32 Shark’s-tooth Full Scan

34 Square-tooth Full Scan

36 Shark’s-tooth Full Scan

36 Square-tooth Full Scan

48 Shark’s-tooth XL Scan

50 Square-tooth XL Scan

64 Shark’s-tooth XL Scan

66 Square-tooth XL Scan
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Silanizing Agent

 

Silanizing Agent
for Preparing Gels

 

Purpose

 

When using a square-tooth comb, silate the unnotched glass plate in 
the well area to facilitate loading samples. Use a silanizing agent such 
as 

 

g

 

-methacryloxypropyltrimethoxysilane (Sigma P/N M6514) to bind 
the gel to the glass. 

 

Procedure

 

Perform the following procedure every time a new gel is poured.

 

! WARNING !

 

CHEMICAL HAZARD. Silanizing agents are irritating to 
the eyes, respiratory system, and skin. Always work in a fume hood. 
Obtain a copy of the MSDS from the manufacturer. Wear appropriate 
protective eyewear, clothing, and gloves.

 

To apply a silanizing agent and remove a gel after a run: 

 

Step Action

1

 

Wash the unnotched glass plate in detergent and distilled water. 
Rinse well in distilled water then air dry.

 

2

 

Apply a small amount of silanizing agent to a cotton swab and 
spread it across the top 3–5 cm of the unnotched glass plate.

 

3

 

Allow the agent to dry thoroughly.

 

4

 

Assemble the plates for the run as usual.

 

5

 

Remove the gel from the silated area with 0.1 N HCl or 0.1 N 
NaOH, or scrape off gently.
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Software

 

Collection
Software

 

The current collection software is version 2.5.

 

GeneScan Analysis

 

The current GeneScan Analysis software is version 3.1 with 
GSGelTracker.

 

Sequence Analysis

 

The current Sequence Analysis software is version 3.3 with 
SAGelTracker.

 

Preference File

 

Define default values in the new software following the procedures 
described under “Setting Preferences” in the 

 

ABI P

 

RISM

 

 377 DNA 
Sequencer

 

 User Manual.

 

The default values you define for Sequencing or GeneScan run 
modules and sample sheets are maintained in the Preference file.

 

Sequencing and
GeneScan Run

Windows

 

The Sequencing and GeneScan Run windows now include the Run 
Mode pulldown menu, as shown below. You can now choose either Full 
Scan (standard with the ABI P

 

RISM

 

 377) or XL Scan (with the upgrade). 
See “Lanes, Combs, and Run Modes Table” on page 5.

Run 
Mode 
pulldown 
menu
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Error Alert
Message

 

The following error message has been added to alert you of a possible 
problem with the heat-transfer plate thermisters.

This message may appear when you open data collection and start a 
plate check, a pre-run, or a run if one of the thermisters is not 
functioning. 

If this message appears, schedule a service call to troubleshoot the 
thermister and continue to operate the instrument as usual.
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CCD Pixel Position Value

 

CCD Pixel Position
Overview

 

The instrument is shipped with the correct CCD pixel position value in 
memory. When a run is started, the software checks for a value greater 
than zero. If the value is lost from memory, an error message is 
displayed at the beginning of the run as shown below.

The CCD pixel position value may become corrupted as the result of a 
power surge or failure. If this occurs, you must find the correct value and 
enter it as described in the following procedures before starting a run.

 

Locating the CCD
Pixel Position

Label

 

The correct CCD pixel position value is written on a white label on the 
CCD camera. It is visible from the front through the opening below the 
rear heat-transfer plate, as shown below. 

Rear heat-transfer plate

CCD camera with pixel 
position label visible here
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Note

 

The following procedure requires the use of a flashlight.

 

To locate the CCD pixel position value on the label:

 

Entering the
Correct CCD Pixel

Position Value

 

To enter the correct CCD pixel position value in the calibration file:

 

Step Action

1

 

Open the front door of the instrument.

 

2

 

Shine a light through the opening below the rear heat-transfer plate 
to view the white label on the CCD camera.

 

3

 

Record the value from the white label.

 

4

 

If you cannot find the label, call technical support.

 

Step Action

1

 

Turn power on to the instrument.

 

2

 

Select Manual Control from the Window menu. 

 

3

 

Open the Fxn Name pulldown menu.

 

4

 

Select the CCD Pixel Position function.

The current pixel position value is displayed.

 

5

 

Compare the displayed value with the value on the white label.

If the pixel position is... Then...

the same as the value on the 
white label

Stop here.

different than the value on the 
white label

a. Select the text box and 
type the correct CCD 
pixel position value.

b. Click Execute.

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



11

Using Calibration
File Make

IMPORTANT You must have the correct CCD pixel position value in 
instrument memory before using the Calibration File Make or Send functions.

Use the Calibration File Make function from the Manual Control Window 
to create the ABI 377XL Calibration file and store the CCD pixel position 
value and instrument serial number in it. 

When created, the file is named ABI 377XL Calibration and is placed in 
the Preferences folder inside the System folder. To read, edit, or print 
the Calibration file, use the SimpleText application.

Creating a Calibration File

To create a Calibration file with Calibration File Make:

Entering the Serial
Number

To enter the instrument serial number in the calibration file:

Step Action

1 Turn on power to the instrument.

2 Select Manual Control from the Window menu. 

3 Open the Fxn Name pulldown menu.

4 Select Calibration File Make.

5 Click Execute.

Step Action

1 Make a note of the serial number from the back of the instrument.

2 Open the System Folder and the Preferences Folder inside the 
System Folder.

3 Open the ABI 377XL Calibration file.

4 Using SimpleText, type the instrument serial number or name (up to 
eight characters) by replacing the question marks.

5 Select Save from the File menu.

6 Close the ABI 377XL Calibration File window.

7 Quit the SimpleText program.
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Using Calibration
File Send

IMPORTANT You must have the correct CCD pixel position value in 
instrument memory before using the Calibration File Make or Send functions.

After creating a Calibration file, use Calibration File Send from the 
Manual Control window to send the instrument’s serial number (or 
name) and CCD pixel position value to the instrument. These values will 
be displayed in the Collection Log window. 

The serial number (or name) is transferred into all sample files created 
by the instrument. It can be viewed in the annotative view of the sample 
file. This is useful for identifying instruments, particularly if you operate 
more than one instrument.

To transfer a Calibration file with Calibration File Send:

Step Action

1 Turn on power to the instrument.

2 Select Manual Control from the Window menu. 

3 Open the Fxn Name pulldown.

4 Select Calibration File Send.

5 Click Execute.
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Module Files

Unused Module
Folder

Move all of the module files that you do not intend to use from the 
Modules folder into the Unused Modules folder.

Collection 2.5
Module Files

The following table lists the module files in Collection Software v. 2.5.

2.5 Collection Module Filesa 

377XL Modules Chiller Modules

GS PR 12A-1200 GS PR 12A-1200 CHILLER

GS PR 12A-2400 GS PR 12A-2400 CHILLER

GS PR 12C-1200 GS PR 12C-1200 CHILLER

GS PR 12C-2400 GS PR 12C-2400 CHILLER

GS PR 12D-1200 GS PR 12D-1200 CHILLER

GS PR 12D-2400 GS PR 12D-2400 CHILLER

GS PR 12F-1200 GS PR 12F-1200 CHILLER

GS PR 12F-2400 GS PR 12F-2400 CHILLER

GS PR 36A-1200 GS PR 36A-1200 CHILLER

GS PR 36A-2400 GS PR 36A-2400 CHILLER

GS PR 36C-1200 GS PR 36C-1200 CHILLER

GS PR 36C-2400 GS PR 36C-2400 CHILLER

GS PR 36D-1200 GS PR 36D-1200 CHILLER

GS PR 36D-2400 GS PR 36D-2400 CHILLER

GS PR 36F-1200 GS PR 36F-1200 CHILLER

GS PR 36F-2400 GS PR 36F-2400 CHILLER

GS Run 12A-1200 GS Run 12A-1200 CHILLER

GS Run 12A-2400 GS Run 12A-2400 CHILLER

GS Run 12C-1200 GS Run 12C-1200 CHILLER

GS Run 12C-2400 GS Run 12C-2400 CHILLER

GS Run 12D-1200 GS Run 12D-1200 CHILLER

GS Run 12D-2400 GS Run 12D-2400 CHILLER

GS Run 12F-1200 GS Run 12F-1200 CHILLER

GS Run 12F-2400 GS Run 12F-2400 CHILLER

GS Run 2140V A CHILLER

GS Run 2140V C CHILLER
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GS Run 2140V D CHILLER

GS Run 2140V F CHILLER

GS Run 36A-1200 GS Run 36A-1200 CHILLER

GS Run 36A-2400 GS Run 36A-2400 CHILLER

GS Run 36C-1200 GS Run 36C-1200 CHILLER

GS Run 36C-2400 GS Run 36C-2400 CHILLER

GS Run 36D-1200 GS Run 36D-1200 CHILLER

GS Run 36D-2400 GS Run 36D-2400 CHILLER

GS Run 36F-1200 GS Run 36F-1200 CHILLER

GS Run 36F-2400 GS Run 36F-2400 CHILLER

GS Run 60W A CHILLER

GS Run 60W C CHILLER

GS Run 60W D CHILLER

GS Run 60W F CHILLER

Plate Check A Plate Check A CHILLER

Plate Check C Plate Check C CHILLER

Plate Check D Plate Check D CHILLER

Plate Check E Plate Check E CHILLER

Plate Check F Plate Check F CHILLER

Seq PR 36A-1200 Seq PR 36A-1200 CHILLER

Seq PR 36A-2400 Seq PR 36A-2400 CHILLER

Seq PR 36E-1200 Seq PR 36E-1200 CHILLER

Seq PR 36E-2400 Seq PR 36E-2400 CHILLER

Seq PR 48A-1200 Seq PR 48A-1200 CHILLER

Seq PR 48E-1200 Seq PR 48E-1200 CHILLER

Seq Run 36A-1200 Seq Run 36A-1200 CHILLER

Seq Run 36A-2400 Seq Run 36A-2400 CHILLER

Seq Run 36E-1200 Seq Run 36E-1200 CHILLER

Seq Run 36E-2400 Seq Run 36E-2400 CHILLER

Seq Run 48A-1200 Seq Run 48A-1200 CHILLER

Seq Run 48E-1200 Seq Run 48E-1200 CHILLER

a. PR = Prerun; Seq = Sequencing; GS = GeneScan

2.5 Collection Module Filesa (continued)

377XL Modules Chiller Modules
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Firmware

Position-Based
Integration

Scheme

Due to the increased demand for positional accuracy of the detection 
optics, a new integration scheme is used. Previously, a given time was 
given to each channel, before reading the CCD camera and switching to 
the next channel. This release of firmware uses position-based CCD 
integration, where predetermined stage positions determine when to 
switch.

Resetting the
Instrument

Reset the instrument under the following situations.

Performing a Total
Reset

To perform a total reset:

Reset the instrument 
when... To reset, perform a...

Resetting is 
necessary because...

new firmware version 
has been downloaded.

single reset. Press the 
reset button once.

the running TPU code 
needs to be 
reinitialized.

IMPORTANT Failure 
to reset the instrument 
will cause a lockup.

the instrument does 
not respond to 
commands or it 
responds 
inappropriately.

total reset. Follow the 
procedure that follows.

the firmware image 
may be corrupted.

Step Action

1 Using the eraser end of a pencil or similar object, press the red 
reset button on the back of the instrument twice in rapid 
succession.

2 Quit the data collection software.
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3 Launch the data collection software. 

The firmware is automatically downloaded to the instrument. This 
will take 60–90 seconds.

4 In response to this prompt, quit and then relaunch the data 
collection software.

5 Check the CCD pixel position value as follows:

a. Open the Window menu and select Manual Control.

b. Open the Fxn Name menu and select CCD Pixel Position 
Value.

The value is displayed in the Value box. If it matches the value on 
the instrument, it is OK. If it does not match, correct the value.

Step Action
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T
temperature error 8
total reset, performing a 15
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Worldwide Sales Offices
Applied Biosystems vast distribution and 
service network, composed of highly trained 
support and applications personnel, reaches 
into 150 countries on six continents. For 
international office locations, please call our 
local office or refer to our web site at 
www.appliedbiosystems.com.  

Headquarters
850 Lincoln Centre Drive
Foster City, CA 94404 USA
Phone: +1 650.638.5800
Toll Free: +1 800.345.5224
Fax: +1 650.638.5884

www.appliedbiosystems.com

PE Corporation is committed to providing 
the world’s leading technology and 
information for life scientists. PE Corporation 
consists of the Applied Biosystems and 
Celera Genomics businesses.

Printed in the USA, 09/2000
Part Number 904412C

Technical Support
For technical support:
Toll Free: +1 800.831.6844 ext 23
Fax: +1 650.638.5891
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Artisan Technology Group is an independent supplier of quality pre-owned equipment 

Gold-standard solutions 
Extend the life of your critical industrial, 

commercial, and military systems with our 

superior service and support. 

We buy equipment 
Planning to upgrade your current 

equipment? Have surplus equipment taking 

up shelf space? We'll give it a new home. 

Learn more! 
Visit us at artisantg.com for more info 

on price quotes, drivers, technical 

specifications, manuals, and documentation. 

Artisan Scientific Corporation dba Artisan Technology Group is not an affiliate, representative, or authorized distributor for any manufacturer listed herein. 

We're here to make your life easier. How can we help you today? 
(217) 352-9330 I sales@artisantg.com I artisantg.com 


